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Programmation Orientée Objet   | OOP - Étude de cas D&D

OOP - Étude de cas D&D

Module 1 — Pourquoi la POO ?
Tu connais déjà la programmation procédurale. Dans ce module, tu vas voir ce qui se passe quand un programme
grandit... et pourquoi la POO est une réponse à ce problème.

0. Mise en place — Rider & premier projet C#

Créer le projet
Dans Rider : File > New Solution, choisis Console Application, framework .NET 8 (ou la version disponible), nom du
projet DnD_Procedural. Rider génère automatiquement un fichier Program.cs avec un Hello World.

La structure que tu vas voir dans l'explorateur de projet :

DnD_Procedural/
├── DnD_Procedural.csproj   ← configuration du projet
└── Program.cs              ← ton code

Lancer et déboguer

Action Raccourci Rider

Lancer le programme Shift + F10

Lancer en mode débogage Shift + F9

Poser un point d'arrêt Clic dans la marge gauche (pastille rouge)

Avancer pas à pas F8 (Step Over)

Entrer dans une méthode F7 (Step Into)

Conseil Rider : quand tu poses un point d'arrêt sur une ligne comme pv2 -= degats1;, tu vois dans le panneau
Debug la valeur de chaque variable au moment exact de l'exécution. C'est très utile pour comprendre ce qui se
passe réellement.

1. Le programme de départ — version

procédurale

Tu reconnais ce contexte : un générateur de personnages D&D. Tu l'as déjà écrit en Python. Voici une version C#
procédurale — sans classe, sans objet.

http://localhost:3111/articles/oop/oop-etude-cas/
http://localhost:3111/articles/oop/__oop/
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1 // Programme procédural — D&D
2 // Un seul personnage, tout à plat
3 // donjon_v1.cs
4
5 using ;
6
7 class Program
8 {
9     static void Main()
10     {
11         // --- Données du personnage 1 ---
12         string nom = "Aragorn";
13         string classe = "Guerrier";
14         int pointsDeVie = 100;
15         int attaque = 15;
16         int defense = 10;
17         bool estVivant = true;
18
19         // --- Afficher le personnage ---
20         Console.WriteLine("=== Personnage ===");
21         Console.WriteLine($"Nom     : {nom}");
22         Console.WriteLine($"Classe  : {classe}");
23         Console.WriteLine($"PV      : {pointsDeVie}");
24         Console.WriteLine($"ATQ     : {attaque}");
25         Console.WriteLine($"DEF     : {defense}");
26         Console.WriteLine($"Vivant  : {estVivant}");
27
28         // --- Attaque ---
29         int degats = attaque - 3; // calcul simplifié
30         Console.WriteLine($"\n{nom} attaque et inflige {degats} dégâts.");
31
32         // --- Recevoir des dégâts ---
33         int degatsRecus = 20;
34         pointsDeVie -= degatsRecus;
35         if (pointsDeVie <= 0)
36         {
37             pointsDeVie = 0;
38             estVivant = false;
39         }
40         Console.WriteLine($"{nom} reçoit {degatsRecus} dégâts. PV restants : {pointsDeVie}");
41     }
42 }

Résultat :

=== Personnage ===
Nom     : Aragorn
Classe  : Guerrier
PV      : 100
ATQ     : 15
DEF     : 10
Vivant  : True

Aragorn attaque et inflige 12 dégâts.
Aragorn reçoit 20 dégâts. PV restants : 80

Ça fonctionne. Pour un seul personnage.

System
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2. Le problème — ajouter un deuxième

personnage

Maintenant le client veut deux personnages qui peuvent se battre. On fait comment ?

1 // Version procédurale — 2 personnages
2 // ⚠️ Tout commence à devenir difficile à lire
3 // donjon_v2.cs
4 using ;
5
6 class Program
7 {
8     static void Main()
9     {
10         // --- Personnage 1 ---
11         string nom1 = "Aragorn";
12         string classe1 = "Guerrier";
13         int pv1 = 100;
14         int attaque1 = 15;
15         int defense1 = 10;
16         bool vivant1 = true;
17
18         // --- Personnage 2 ---
19         string nom2 = "Legolas";
20         string classe2 = "Archer";
21         int pv2 = 80;
22         int attaque2 = 18;
23         int defense2 = 7;
24         bool vivant2 = true;
25
26         // --- Aragorn attaque Legolas ---
27         int degats1 = attaque1 - defense2;
28         if (degats1 < 0) degats1 = 0;
29         pv2 -= degats1;
30         if (pv2 <= 0) { pv2 = 0; vivant2 = false; }
31         Console.WriteLine($"{nom1} attaque {nom2} : {degats1} dégâts. PV de {nom2} : {pv2}");
32
33         // --- Legolas attaque Aragorn ---
34         int degats2 = attaque2 - defense1;
35         if (degats2 < 0) degats2 = 0;
36         pv1 -= degats2;
37         if (pv1 <= 0) { pv1 = 0; vivant1 = false; }
38         Console.WriteLine($"{nom2} attaque {nom1} : {degats2} dégâts. PV de {nom1} : {pv1}");
39
40         // --- Résumé ---
41         Console.WriteLine($"\n{nom1} — PV : {pv1} — Vivant : {vivant1}");
42         Console.WriteLine($"{nom2} — PV : {pv2} — Vivant : {vivant2}");
43     }
44 }

Ça marche encore. Mais regarde ce qui se passe avec cinq personnages :

1 string nom1, nom2, nom3, nom4, nom5;
2 string classe1, classe2, classe3, classe4, classe5;

System
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3 int pv1, pv2, pv3, pv4, pv5;
4 int attaque1, attaque2, attaque3, attaque4, attaque5;
5 int defense1, defense2, defense3, defense4, defense5;
6 bool vivant1, vivant2, vivant3, vivant4, vivant5;
7 // ... et toute la logique d'attaque répétée 25 fois

Questions à te poser :

Si tu dois corriger le calcul de dégâts, combien d'endroits dans le code dois-tu modifier ?
Que se passe-t-il si tu oublies d'en modifier un ?
Comment faire pour avoir un nombre de personnages choisi par l'utilisateur ?

3. Une tentative avec des tableaux

On peut améliorer avec des tableaux :

1 // Tentative avec tableaux — procédural amélioré
2
3 string[] noms     = { "Aragorn", "Legolas", "Gimli" };
4 string[] classes  = { "Guerrier", "Archer", "Nain" };
5 int[]    pv       = { 100, 80, 120 };
6 int[]    attaque  = { 15, 18, 12 };
7 int[]    defense  = { 10, 7, 14 };
8 bool[]   vivants  = { true, true, true };
9
10 // Afficher tous les personnages
11 for (int i = 0; i < noms.Length; i++)
12 {
13     Console.WriteLine($"{noms[i]} ({classes[i]}) — PV : {pv[i]}");
14 }

C'est mieux pour l'affichage. Mais pour attaquer :

1 // Aragorn (index 0) attaque Legolas (index 1)
2 int attaquant = 0;
3 int cible = 1;
4
5 int degats = attaque[attaquant] - defense[cible];
6 if (degats < 0) degats = 0;
7 pv[cible] -= degats;
8 if (pv[cible] <= 0) { pv[cible] = 0; vivants[cible] = false; }
9 Console.WriteLine($"{noms[attaquant]} inflige {degats} dégâts à {noms[cible]}.");

Ça fonctionne. Mais les données d'un personnage sont éparpillées dans 6 tableaux différents. Si on veut ajouter un
attribut mana, on ajoute un 7e tableau. Si on se trompe d'index dans un tableau, on a un bug difficile à trouver.

4. Le diagnostic — ce qui ne va pas

Voici les problèmes que tu viens d'observer :
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Problème Conséquence

Les données d'un même personnage sont séparées Un bug dans un index casse tout

La logique d'attaque est copiée-collée Une correction doit être faite partout

Impossible d'encapsuler une règle métier N'importe qui peut mettre pv[0] = -999

Difficile d'ajouter un nouvel attribut Il faut modifier le code à 10 endroits

Pas de moyen naturel de "passer un personnage" à une fonction On passe 6 paramètres séparés

5. L'intuition objet — regrouper ce qui va

ensemble

Avant même d'écrire une seule ligne de C# orienté objet, réfléchis à cette question :

Qu'est-ce qu'un personnage D&D ?

C'est un paquet de données (nom, classe, PV, attaque, défense, état vivant/mort) plus un ensemble de

comportements (attaquer, recevoir des dégâts, afficher son état, soigner…).

Idéalement, on voudrait écrire :

1 // Ce qu'on voudrait pouvoir écrire
2 Personnage aragorn = new Personnage("Aragorn", "Guerrier", 100, 15, 10);
3 Personnage legolas = new Personnage("Legolas", "Archer", 80, 18, 7);
4
5 aragorn.Attaquer(legolas);
6 legolas.Attaquer(aragorn);
7
8 aragorn.Afficher();
9 legolas.Afficher();

C'est exactement ce que la POO permet.

6. La version orientée objet

Voici la même logique, réécrite avec une classe.

Organisation dans Rider : dans un projet objet, chaque classe vit idéalement dans son propre fichier. Crée un
nouveau fichier avec Clic droit sur le projet > Add > New File > Class, nomme-le Personnage.cs. Rider génère
automatiquement la structure de base. Program.cs ne contient plus que le Main().
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1 using ; 
2
3 class Personnage
4 {
5     // --- Attributs ---
6     public string Nom;
7     public string Classe;
8     public int PointsDeVie;
9     public int Attaque;
10     public int Defense;
11     public bool EstVivant;
12
13     // --- Constructeur ---
14     public Personnage(string nom, string classe, int pv, int attaque, int defense)
15     {
16         Nom = nom;
17         Classe = classe;
18         PointsDeVie = pv;
19         Attaque = attaque;
20         Defense = defense;
21         EstVivant = true;
22     }
23
24     // --- Méthodes ---
25     public void Afficher()
26     {
27         Console.WriteLine($"{Nom} ({Classe}) — PV : {PointsDeVie} — ATQ : {Attaque} — DEF : {Def
28     }
29
30     public void Attaquer(Personnage cible)
31     {
32         int degats = Attaque - cible.Defense;
33         if (degats < 0) degats = 0;
34
35         Console.WriteLine($"{Nom} attaque {cible.Nom} et inflige {degats} dégâts.");
36         cible.PointsDeVie -= degats;
37     }
38 }
39
40 class Program
41 {
42     static void Main()
43     {
44         Personnage aragorn = new Personnage("Aragorn", "Guerrier", 100, 15, 10);
45         Personnage legolas = new Personnage("Legolas", "Archer",    80, 18,  7);
46
47         aragorn.Afficher();
48         legolas.Afficher();
49
50         Console.WriteLine("\n=== Combat ===");
51         aragorn.Attaquer(legolas);
52         legolas.Attaquer(aragorn);
53
54         Console.WriteLine("\n=== Résultat ===");
55         aragorn.Afficher();
56         legolas.Afficher();

System
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57     }
58 }

Résultat :

=== Début du combat ===

[Guerrier] Aragorn — PV : 100 — ATQ : 15 — DEF : 10 — ✔ Vivant
[Archer] Legolas — PV : 80 — ATQ : 18 — DEF : 7 — ✔ Vivant
[Nain] Gimli — PV : 120 — ATQ : 12 — DEF : 14 — ✔ Vivant

=== Tour 1 ===
Aragorn attaque Legolas et inflige 8 dégâts.
Legolas attaque Gimli et inflige 4 dégâts.
Gimli attaque Aragorn et inflige 2 dégâts.

=== Fin du tour ===
[Guerrier] Aragorn — PV : 98 — ATQ : 15 — DEF : 10 — ✔ Vivant
[Archer] Legolas — PV : 72 — ATQ : 18 — DEF : 7 — ✔ Vivant
[Nain] Gimli — PV : 116 — ATQ : 12 — DEF : 14 — ✔ Vivant

7. Comparaison côte à côte

Procédural Orienté objet

Données d'un personnage Éparpillées dans 6 variables Regroupées dans un objet

Logique d'attaque Copiée à chaque attaque Écrite une seule fois dans Attaquer()

Corriger le calcul de dégâts Modifier 10 endroits Modifier 1 seul endroit

Ajouter un 4e personnage Créer 6 nouvelles variables new Personnage(...)

Passer un personnage à une fonction 6 paramètres 1 seul paramètre de type Personnage

Protéger les données Impossible private set empêche la modification directe
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8. Ce que tu dois retenir de ce module

Les 3 idées clés :

1. Une classe regroupe les données ET les comportements qui vont naturellement ensemble.
2. Un objet est une instance d'une classe — chaque personnage est un objet indépendant.
3. La logique métier est écrite une seule fois dans la classe — pas copiée-collée partout.

Exercices

Ex. 1 — Lire et comprendre
Dans Rider, crée un nouveau projet Console Application (.NET) (File > New Solution > Console Application), colle
le code de la section 6 et lance-le avec Run (▶ ) ou Shift+F10. Modifie les valeurs initiales des personnages et
observe comment le résultat change. Ajoute un 4e personnage (Gandalf, Mage, 70, 25, 5) et fais-le participer au
combat.

Ex. 2 — Étendre la classe
Ajoute une méthode Soigner(int soin) qui augmente les PV d'un personnage sans dépasser une valeur maximale.
Définis cette valeur maximale comme attribut (initialisé à la construction à la même valeur que les PV de départ).

Ex. 3 — Comparer (discussion en classe)
Dans le programme procédural avec tableaux (section 3), que se passe-t-il si l'utilisateur entre 10 personnages dont
les noms sont saisies au clavier ? Écris les 5 premières lignes de ce programme en procédural, puis en orienté objet.
Laquelle préfères-tu ? Pourquoi ?

UAA 14 — Module 1 — 6e TTR Informatique
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